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Flat Plate Boundary Layer

Chapter 2 Flat Plate Boundary Laver

Objectives

e Creating the SOLIDWORKS part needed for the Flow Simulation

e Setting up Flow Simulation projects for internal flow

e Setting up a two-dimensional flow condition

e Initializing the mesh

e Selecting boundary conditions

e Inserting global goals, point goals and equation goals for the calculations

e Running the calculations

e Using Cut Plots to visualize the resulting flow field

e Use of XY Plots for velocity profiles, boundary layer thickness, displacement thickness,
momentum thickness and friction coefficients

e Use of Excel templates for XY Plots

e Comparison of Flow Simulation results with theories and empirical data

e Cloning of the project

Problem Description

In this chapter, we will use SOLIDWORKS Flow Simulation to study the two-dimensional
laminar and turbulent flow on a flat plate and compare with the theoretical Blasius boundary layer
solution and empirical results. The inlet velocity for the 1 m long plate is 5 m/s and we will be
using air as the fluid for laminar calculations and water to get a higher Reynolds number for
turbulent boundary layer calculations. We will determine the velocity profiles and plot the
profiles using the well-known boundary layer similarity coordinate. The variation of boundary-
layer thickness, displacement thickness, momentum thickness and the local friction coefficient
will also be determined. We will start by creating the part needed for this simulation; see figure
2.0.

Inlet section _ _
Lines for velocity profiles

Outlet section

Ideal walls
Real wall

Figure 2.0 SOLIDWORKS model for flat plate boundary layer study
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Flat Plate Boundary Layer

Creating the SOLIDWORKS Part

1.

Start by creating a new part in SOLIDWORKS: select File>>New and click on the OK button in
the New SOLIDWORKS Document window. Click on Front Plane in the FeatureManager
design tree and select Front from the View Orientation drop down menu in the graphics

window.

G BB % €
N

@y #@ Partl (Default<<Default> Displa

History
Sensors

L4 Annotations @*@*@&*Q'
E% Material <not specified> W @ b

s
[ﬂ Top Plane — =
&0 o

[1] Right Plane
1, origin Front (Ctrl+1)
Figure 2.1a) Selection of front plane Figure 2.1b) Selection of front view

Click on the Sketch tab and select Corner Rectangle.

e . _.
DS SOLIDWORKS File Edit Vie
C & /-©&-N-
Sketch Smart -

= Dimr:r?sicun ET Eqn M @ T _.:':;L

T T Iﬁ_"(Zt:lnrn«er Rectangle

Features | Sketch F Sketches a rectangle,

Figure 2.2a) Selecting a sketch tool

Make sure that you have MMGS (millimeter, gram, second) chosen as your unit system. You can
check this by selecting Tools>>Options from the SOLIDWORKS menu and selecting the
Document Properties tab followed by clicking on Units. Check the circle for MMGS and click
on the OK button to close the window. Click to the left and below the origin in the graphics
window and drag the rectangle to the right and upward. Fill in the parameters for the rectangle;

W

. Right click in the graphics

see Figure 2.3a). Close the Rectangle dialog box by clicking on

window and select Zoom/Pan/Rotate>>ﬁ:a Zoom to Fit.
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Parameters ~
o -100.00 :
., 0.00 :
o -100.00 :
°, 100.00 :
° 1000.00 :
°, 100.00 :
° 1000.00 :
s 0.00 :

Figure 2.3a) Parameter settings for the rectangle

| Zoom/Pan/Rotate » |||ﬁ') Zoom to Fit

Figure 2.3b) Zooming in the graphics window

4. Repeat steps 2 and 3 but create a larger rectangle outside of the first rectangle. Dimensions are
shown in figure 2.4.

Parameters ~
L. -120.00 :
L= -20.00 :
L. -120.00 :
., 120.00 :
L. 1020.00 :
L 120.00 :
L 1020.00 :
sl -20.00 :

Figure 2.4 Dimensions of second larger rectangle
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5. Select Features tab and Extruded Boss/Base. Check the box for [¥] Direction 2 and click

OK to exit the Boss-Extrude Property Manager.

7 F .
DS SOLIDWORKS | File Edit

ﬁ @ @ Swept Boss/Base

Extruded | Revolved
Boss/Base | Boss/Base

Extruded Boss/Base

Extrudes a sketch or selected sketch
contours in one or two directions to
create a solid feature.

Figure 2.5a) Selection of extrusion feature

? .
JE’S SOLIDWORKS |  File Ec

Features | Sketch | Evaluate | MBD Di

G EIR[&[€. ]

@] Boss-Extrude @

v x ®

Figure 2.5b) Closing the property manager

6. Seclect Front from the View Orientation drop down menu in the graphics window. Click on
Front Plane in the FeatureManager design tree. Click on the Sketch tab and select the Line
sketch tool.

? e £
_] DS SOLIDWORKS |  File Edit

cC & /A6-N-
Sketch amart
Dimension Line (L)

= = Sketches a line.

Figure 2.6 Selection of the line sketch tool
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7. Draw a vertical line in the Y-direction in the front plane starting at the lower inner surface of the
sketch. Set the Parameters and Additional Parameters to the values shown in figure 2.7. Close

. . . v . )
the Line Properties dialog and the Inert Line dialog.
Parameters ta
& 2000 Es
i
A - o
|1 90.00 <
Additional Parameters -
7 200.00 -
x -
/ 0.00 -
¥ -
e 200,00 i
x -
/ 20.00 -
¥ -
AX 000 %
AY 2000 |-

Figure 2.7 Parameters for vertical line

8. Repeat steps 6 and 7 three more times and add three more vertical lines to the sketch: the second
line at X = 400 mm with a length of 40 mm, the third line at X = 600 mm with a length of 60 mm
and the fourth line at X = 800 mm with a length of 80 mm. These lines will be used to plot the
boundary layer velocity profiles at different streamwise positions along the flat plate. Close the

Line Properties dialog o and the Insert Line dialog. Save the SOLIDWORKS part with the
following name: Flat Plate Boundary Layer Study 2019. Rename the newly created sketch in

the FeatureManager design tree; see figure 2.8. You will need to left click twice to rename the
sketch.

% 'ﬂ' Flat Plate Boundary Layer Study 2019
y History
Sensors
» Annotations
+ [®)] Selid Bodies(1)
E% Material <not specified>
[ﬂ Front Plane
[ﬂ Top Plane
[1] Right Plane
L Origin
* @ Boss-Extrudel
[ (9x=02,04,06,08m
Figure 2.8 Renaming the sketch for boundary layer velocity profiles
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9. Click on the Rebuild symbol e in the SOLIDWORKS menu. Repeat step 6 and draw a
horizontal line in the X-direction starting at the origin of the lower inner surface of the sketch. Set
the Parameters and Additional Parameters to the values shown in figure 2.9 and close the Line
Properties dialog and the Insert Line dialog. Click on the Rebuild symbol. Rename the sketch
in the FeatureManager design tree and call it x=0— 0.9 m.

Parameters Lo
g\ 400.00 2
[% o000 2
Additional Parameters L

0.00

=}
=
=
1 F 4 »
Lo |

4 4P

BN AN

0.00
900,00 =
AY 0.00 -

-

Figure 2.9 Sketch of a line in the X-direction

10. Next, we will create a split line. Repeat step 6 once again but this time select the Top Plane and
draw a line in the Z-direction through the origin of the lower inner surface of the sketch. It will
help to zoom in and rotate the view to complete this step. Set the Parameters and Additional
Parameters to the values shown in figure 2.10 and close the dialog. Click on the Rebuild
symbol.

Parameters

& 2000 2
E 90.00°

1k

Additional Parameters

0.00

1k 4 »

-10.00

0.00

10.00

1k AP

BN NN

»

0.00

1

»

AY 20,00

Figure 2.10 Drawing of a line in the Z-direction
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11. Rename the new sketch in the FeatureManager design tree and call it Split Line. Select
Insert>>Curve>>Split Line... from the SOLIDWORKS menu. Select Projection under Type
to Split. Select Split Line for Sketch to Project under Selections. For Faces to Split, select the

surface where you have drawn your split line; see figure 2.11b). Close the dialog Y|, You have
now finished the part for the flat plate boundary layer. Select File>>Save from the
SOLIDWORKS menu.
Tools Window Help 8 ‘ ﬁ- D -
Boss/Base »
Cut 3
Features »
Pattern/Mirror »
Fastening Feature [
FeatureWorks »
Surface »
Face b
| Curve [ |@ Split Line...
Figure 2.11a) Creating a split line
Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | SOLIDWORKS CAM TEM |
el - @ Flat Plate Boundary Layer ... p ﬁ @2 Q_E @ E ﬁ @ (F E
@ ER ¢
& Split Line )
v X
Type of Split -~
() Silhouette
@ Projection
() Intersection
Selections A~
E split Line

(]

3 |

o
Single direction
|:| Reverse direction

Figure 2.11b) Selection of surface for the split line
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Setting Up the Flow Simulation Project

12. If Flow Simulation is not available in the menu, you have to add it from SOLIDWORKS menu:
Tools>>Add Ins... and check the corresponding SOLIDWORKS Flow Simulation 2019 box
under SOLIDWORKS Add-Ins and click OK to close the Add-Ins window. Select Tools>>Flow
Simulation>>Project>>Wizard to create a new Flow Simulation project. Enter Project name:
“Flat Plate Boundary Layer Study”. Click on the Next > button. Select the default SI (m-kg-s)
unit system and click on the Next> button once again.

Tools | Window  Help A @D*E?*ﬁ*g*%'. Ii:t:;[}l*Fla...@

SOLIDWORKS Applications k E
Xpress Products b pplay/Delete oo pair | QUK | papid

Flow Simulation » Project Pl New..

SOLIDWORKS CAM » __— . % Wizard...

Figure 2.12a) Starting a new Flow Simulation project

,
wews popene

Praoject

Froject name: Flat Plate Boundary Layer Study

Comments:

Figure 2. 12b) Creating a name for the project

13. Use the default Internal Analysis type and click on the Next> button once again.

,

Analyziz type Congider cloged cavities
@ Internal Erclude cavities without flow conditions [l
() External [ Exclude internal space

Physical Features “alue

Heat conduction in solids

Radiation

Time-dependent

Gravity

Rotation

Free surface

Figure 2.13 Exclusion of cavities without flow conditions
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14. Select Air from the Gases and add it as Project Fluid. Select Laminar Only from the Flow
Type drop down menu. Click on the Next > button. Use the default Wall Conditions and click
on the Next > button. Insert S m/s for Velocity in X direction as Initial Conditions and click on
the Finish button. You will get a fluid volume recognition failure message. Answer Yes to this
question and create a lid on each side of the model. Answer Yes to the questions when you create

the lids.

, ‘

Humidity

High Mach number flow

Fluids | Path | = ew,.. ®
= Gases
i Acetone Pre-Defined
Ammonia Pre-Defined
s Argon Pre-Defined
i Butane Pre-Defined
i Carbon dioxide Pre-Defined
- Chlorine Pre-Defined
£ Ethane Pre-Defined
i Ethanol Pre-Defined
Ethylene Pre-Defined
Fluorine Pre-Defined h Add
| Project Fluids | Defautt Fiuid | R
Alr ( Cases )
Flow Characteristic Value -
Flow type Laminar Only E

Figure 2.1 4 ectlo of fluid for the project and flow type

»

15. Select Tools>>Flow Simulation>>Computational Domain.... Click on the 2D simulation

button under Type and select XY plane. Close the Computational Domain dialog

v

Window Help »

A0 FH-E@-2-9-3

SOLIDWORKS Applications

Xpress Products

2

3

| Flow Simulation

3

SOLIDWORKS CAM
ANSY517.1

ﬁ’ Azzet Publisher...

EL Defeature..

Project
Insert

General Settings...

E Units...

| @ Computational Domain...

Figure 2.15a) Modifying the computational domain

@ Computational Domain @
v X
Type ~
@ 3D simulation
@ 2D simulation

@ XY plane

Figure 2.15b) Selecting 2D simulation in the XY plane
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16. Select Tools>>Flow Simulation>>Global Mesh.... Select Manual under Type. Change Nx to
300 and Ny to 200. Click on the OK button (green check mark) to exit the Initial Mesh window.

Tools | Window Help » ﬁ-Dv@-ﬁ-%vﬁ'}-E

SOLIDWORKS Applications »
Xpress Products r |
Flow Simulation r Project
SOLIDWORKS CAM 3
Insert
ANSYS17.1 »

General Settings...
ﬁ Asset Publisher...

_'4:__: Units...
B, Defeature... @ Computational Domain...
2 EBport To AEC.. B Global Mesh..

Figure 2.16a) Modifying the initial mesh

) Global Mesh Settings @
v X

Automatic
Manual

Basic Mesh L
Nx 300 -
Ny 200 -

Figure 2.16b) Changing the number of cells in two directions

Selecting Boundary Conditions

17. Select the < Flow Simulation analysis tree tab, open the Input Data folder by clicking on
the plus sign next to it and right click on Boundary Conditions. Select Insert Boundary
Condition.... Select Wireframe as the Display Style. Right click in the graphics window and
select Zoom/Pan/Rotate>>Zoom to Fit. Once again, right click in the graphics window and
select Zoom/Pan/Rotate>>Rotate View. Click and drag the mouse so that the inner surface of
the left boundary is visible. Right click again and unselect Zoom/Pan/Rotate>>Rotate View.
Right click on the left inflow boundary surface and select Select Other. Select the Face
corresponding to the inflow boundary. Select Inlet Velocity in the Type portion of the Boundary
Condition window and set the velocity to 5 m/s in the Flow Parameters window. Click OK to

exit the window. Right click in the graphics window and select & Zoom to Area and select an
area around the left boundary.
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@? Flat Plate Boundary Layer Study
E@ Input Data

------- @ Computational Domain

------ @ Fluid Subdomains Zoom/Pan/Rotate k p Zoom to Fit
-] Boundary Conditions p‘ Zoom to Area
iR Goals v 0K

IO Zoom In/Out
¥ Cancel p

- @B Results (Not loaded) ™ Rotate View

Figure 2.17a) Inserting boundary condition Figure 2.17b) Modifying the view

Ef| Inlet Velocity 1 @
v X

Seloction N
@ Face<lx

é—"&x Face Coordinate Spstem

Reference axis:

Type

(e

Inlet Mass Flow
Inlet Mass Flux
Inlet Volume Flow

Inlet Velocity

Inlet Mach Number
Cutlet Mass Flow
Outlet Volume Flow

Flow Parameters

Bl[e=] 4]
V smis =13

Fully developed flow

Figure 2.17c) Velocity boundary condition on the inflow
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Flat Plate Boundary Layer

Figure 2.17d) Inlet velocity boundary condition indicated by arrows

Red arrows pointing in the flow direction appears indicating the inlet velocity boundary
condition; see figure 2.17d). Right click in the graphics window and select Zoom to Fit. Right
click again in the graphics window and select Rotate View once again to rotate the part so that

the inner right surface is visible in the graphics window. Right click and click on ESelect.

Right click on i Boundary Conditions in the Flow Simulation analysis tree and select
Insert Boundary Condition.... Right click on the outflow boundary surface and select Select
Other. Select the Face corresponding to the outflow boundary. Click on the Pressure Openings
button in the Type portion of the Boundary Condition window and select Static Pressure. Click
OK to exit the window. If you zoom in on the outlet boundary you will see blue arrows indicating
the static pressure boundary condition; see figure 2.18b).

éfox Face Coordinate System

Reference axis: Q
101325 Pa
~
[= | @]

Environment Pressure

Type

Static Pressure
Total Pressure

Thermodynamic Parameters ~
P 101325 Pa
T 2932k

Goals w

Figure 2.18a) Selection of static pressure as boundary condition at the outlet of the flow region

Chapter 2 - 12 -



Flat Plate Boundary Layer

1
1
|
i
1
1
1
1
1
1
1
1
1
|
|
|
|
1
1
1
1
1
1
1
1

1
Figure 2.18b) Outlet static pressure boundary condition

19. Enter the following boundary conditions: Ideal Wall for the lower and upper walls at the inflow
region; see figures 2.19. These will be adiabatic and frictionless walls.

i FI

F Ideal Wall 1 @
v X
Selection ~
@ Fate<l>

Face<3>

[
}zf»x Global Coordinate Spztemn
Reference axis: g}

Type ~

BE)

| Real Wall ‘

Figure 2.19 Ideal wall boundary condition for two wall sections
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20. The last boundary condition will be in the form of a Real Wall. We will study the development
of the boundary layer on this wall.

-’F’r Face Coordinate System

Reference axis: 5'

Type 2

&SI
Real Wall |
Ideal Wall

Figure 2.20 Real wall boundary condition for the flat plate

Inserting Global Goals

21. Right click on Goals in the Flow Simulation analysis tree and select Insert Global Goals....
Select Friction Force (X) as a global goal. Exit the Global Goals window. Right click on Goals

X
in the Flow Simulation analysis tree and select Insert Point Goals.... Click on the Ijl Point
Coordinates button. Enter 0.2 m for X coordinate and 0.02 m for Y coordinate and click on the

Add Point button \i‘ Add three more points with the coordinates shown in figure 2.21e). Check
the Value box for Velocity (X). Exit the Point Goals window. Rename the goals as shown in
figure 2.21f). Right click on Goals in the Flow Simulation analysis tree and select Insert
Equation Goal.... Click on PG Velocity (X) at x = 0.2 m goal in the Flow Simulation analysis
tree, multiply by 0.2 (for x = 0.2 m) and divide by /.5/6E-5—kinematic viscosity of air at room
temperature (v = 1.516E-5 m?/s) to get an expression for the Reynolds number in the Equation
Goal window; see figure 2.21g). Select Dimensionless LMA from the dimensionality drop down
menu. Exit the Equation Goal window. Rename the equation goal to Reynolds number at x =
0.2 m. Insert three more equation goals corresponding to the Reynolds numbers at the three other
x locations. For a definition of the Reynolds number; see page 2-21.
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¥ Global Goals @
v X
Parameters A
Parameter Mir A M BL Us =«
Density (Fluid] v
Mass [Fluid)
Mass Flow Rate =
Velocity
Velocity [¥]
Velocity (1]
Velocity (Z)
Mach Mumber
Heat Flux
Wall Temperature =
Heat Transfer Rats

£5: Flat Plate Boundary Layer Study

i Total Enthalpy Ra
EI@ Input Data

SoppEEpEmmmpzEECE0800H
FEEEEREEEEEEEEEEEEMEEEEE

: . . Mormal Force
- @ Computational Domain
. . Mormal Force [¥)
o gy Fluid Subdomains Normal Force ]
|_:_|Eﬁ Boundary Conditions Normal Force [Z)
-] Inlet Velocity 1 Force -
------ Eﬁ Static Pressure 1 Force [¥]
------ P Ideal Wall 1 Force [1)
tJH Real Walll Force (Z)
...... P Goal Friction Force
EEI""% MESI Insert Global Goals... Friction Force [¥) /] i
Figure 2.21a) Inserting global goals Figure 2.21b) Selection of friction force
%, Point Goals
v X
Points
S g et
1| Inzert Global Goals... Eﬂ
: Insert Point Goals... 'ﬁj |
Figure 2.21c) Inserting point goals Figure 2.21d) Selecting point coordinates
Add point
xvz ¥ [m] ¥ [m] 7 [m
0.2 0.02 0
0.4 0.02 0
0.6 0.02 0
0.5 0.02 0

Figure 2.21¢) Coordinates for point goals
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- Goals
. L.® GG Friction Force () 1
.# PG Velocity (X) atx=02m

. PG Velocity (X) atx = 0.4 m EEoo | Equation Goal 1 Dimensianless LMA

R, PG Velocity (X) atx=06m [ Expression
F PG Velocity () atx=08 m |{PG Velocity (X) at x =0.2 m}*0.2/1.516E-5

Figure 2.21f) Renaming the point goals  Figure 2.21g) Entering an equation goal

Running the Calculations

22. Select Tools>>Flow Simulation>>Solve>>Run from the SOLIDWORKS menu to start the

calculations. Click on the Run button in the Run window. Click on the goals P button in the
Solver window to see the List of Goals.

Tools | Window Help ﬂ"‘ ﬁ-D*E?*ﬁ*E' '. {C::}*Fla...

SOLIDWORKS Applications 3
Xpress Products k S,ljl,';": .D'-:I'-:t'-: Eepair S Rapid
Flow Simulation k Project
SOLIDWORKS CAM 3
Insert
ANSYS17.1 3

B

General Settings...

2

F @ BB O

Units...

T Asset Publisher..
Sal

so Defeature... Computational Domain...

“* Export To AEC... Global Mesh...
Component Control...
h\ Select
. ] Calculation Control Options...
Q Magnified Selection
l1 Box Selection Solve b || = Run..

Figure 2.22a) Starting calculations

, |
S 0 W

Startup
} Fiun
b ezhy []Take previous results
] schve
@ Mew calculation
Continue calculation

Figure 2.22b) Run window
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=
25 Solver: Flat Plate Boundary Layer Study [Default] (Flat Plate Boundary Layer Study 2019.5LDPRn_

File Calculation View Inset Window Help
=>4 s |[EOF) e 0
>

| O info B Leg

Ml | Parameter Value Event Iteration Tirne

il | Status Solver is finished. Mesh generation started 0 15:22:30
Total cells 60,000 Mesh generation nermally finished 0 15:22:34
Fluid cells 60,000 Preparing data for calculation 0 15:22:35
Fluid cells contacting solids 996 Calculation started 0 15:22:38
Iterations 11 Calculation has converged since the following criteria are satisfied: 121 15:25:07
Last iteration finished 15:25:07 Goals are converged 11
CPU time per last iteration 00:00:01 Calculation finished 11 15:25:09
Travels 1.54539
Iterations per 1 travel FE
Cpu time 0:2:31
Calculation time left 0:0:0
Run at JMATSS0N-PC
Number of cores 8

Name Current Value Progress Criterion Averaged Value
GG Friction Force (X} 1 0000147137 N 05 47404 N
PG Velocity (X) atx=02m 5.06925 m/s 000203831 n  5.06925 m/s

PG Velocity (X) atx=04 m 5.00414 m/s 000278221 n 5.09414 m/=

PG Velocity (X) atx= 0.6 m 511355 m/s 000333439 n 511344 m/s

PG Velocity (X) atx =08 m 513002 m/s 000371083 n 512926 m/s

26,8906 66876.6
73.4092 134410
131.968 202379
195822 270674

Reynolds numberatx=02m 66876.6
Reynolds number atx=04 m 134410
Reynolds number atx=06m 202383
‘Reynolds number atx = 0.8 m 270714

Figure 2.22c) Solver window

Using Cut Plots to Visualize the Flow Field

23. Open the Results folder, right click on R Cut Plots in the < Flow Simulation analysis tree
under Results and select Insert.... Select the Front Plane from the FeatureManager design
tree. Slide the Number of Levels slide bar to 255. Select Pressure from the Parameter drop
down menu. Click OK to exit the Cut Plot window. Figure 2.23a) shows the high pressure region
close to the leading edge of the flat plate. Rename the cut plot to Pressure. You can get more
lighting on the cut plot by selecting Tools>>Flow Simulation>>Results>>Display>>Lighting
from the SOLIDWORKS menu. Right click on the Pressure Cut Plot in the Flow Simulation
analysis tree and select Hide.

Repeat this step but instead choose Velocity (X) from the Parameter drop down menu. Rename

the second cut plot to Velocity (X). Figures 2.23b) and 2.23c¢) show the velocity boundary layer
close to the wall.
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10132627
. 101326.18
101326.08

ro101326.00
r 10132580
ro101324.81

10132572
10132563
101325.54

101325.45
Fo101325.36

10132526
10132517
101325.08
101324.94

Fressure [Pa]

Figure 2.23a) Pressure distribution along the flat plate.

5148
. 4780
4412

r 4.045

I 2942
r 1.838
0.735

ro3.B7T
2474
ro1.471
0.368

r 3.309

2.206

1.103
i

WVelocity (=) [mis]

Figure 2.23b) X — Component of Velocity distribution on the flat plate.

Figure 2.23c) Close up view of the velocity boundary layer.

Using XY Plots with Templates

24. Place the file “graph 2.24c).xIsm” on the desktop. This file and the other exercise files are
available for download at the SDC Publications website. Click on the FeatureManager design

tree. Click on the sketch x = 0.2, 0.4, 0.6, 0.8 m. Click on the < Flow Simulation analysis
tree tab. Right click XY Plot and select Insert.... Check the Velocity (X) box. Open the
Resolution portion of the XY Plot window and slide the Geometry Resolution as far as it goes
to the right. Click on the Evenly Distribute Output Points button and increase the number of
points to 500. Open the Options portion and check the Display boundary layer box. Select the
“Excel Workbook (*.xIsx)” from the drop down menu. Click Export to Excel to create the XY
Plot window. An Excel file will open with a graph of the velocity in the boundary layer at
different streamwise positions.
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Double click on the graph 2.24c¢) file to open the file. Click on Enable Content if you get a
Security Warning that Macros have been disabled. If Developer is not available in the menu of
the Excel file, you will need to do the following: Select File>>Options from the menu and click
on the Customize Ribbon on the left hand side. Check the Developer box on the right hand side
under Main Tabs. Click OK to exit the Excel Options window.

Click on the Developer tab in the Excel menu for the graph 2.24c¢) file and select Visual Basic
on the left hand side to open the editor. Click on the plus sign next to VBAProject (XY Plot
1.xIsx) and click on the plus sign next to Microsoft Excel Objects. Right click on Sheet2 (Plot
Data) and select View Object.

Select Modulel in the Modules folder under VBAProject (graph 2.24¢).xlsm). Select
Run>>Run Macro from the menu of the MVB for Applications window. Click on the Run
button in the Macros window. Figure 2.24c) will become available in Excel showing the
streamwise velocity component u (m/s) versus wall normal coordinate y (m). Close the XY Plot
window and the graph 2.24c) window in Excel. Exit the XY Plot window in SOLIDWORKS
Flow Simulation and rename the inserted xy-plot in the Flow Simulation analysis tree to
Laminar Velocity Boundary Layer.

Parameters -~
EAII -
[Cpensity (Fluid)
G [B[B[S[@]&] |Dre
DTemperature
? DTemperature [Fluid)
% ﬂ Flat Plate Boundary Layer Study 2017 DVEIGCU .
~—
2 History [Clvelocity 1)
Sensors [Clvelocity @)
—— . DMach Mumber
k Annotatmns Flvelocity RRF
e o - i

v [@] Solid Bodies(3) C

[ More Parameters... ]

o—
2—@ Material <not specified>

[j_-] Front Plane Resolution 2
[ﬂ Top Plane Ay {J

o
[ﬂ Right Plane p— o

L Origin

* @ Boss-Extrudel Options -
|E (-)x=0204 06 08m [¥] Use CAD geometry
E (-)x=0-09m [¥]Interpolate
F @ Split Linel [¥] Display boundary layer
LID1 Merge connected lines
LID2 ’Eltcel Workbook [*.xlsy) v]
Figure 2.24a) Sketch for the XY Plot Figure 2.24b) Settings for the XY Plot
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Figure 2.24c) Boundary layer velocity profiles on a flat plate at different streamwise positions

Comparison of Flow Simulation Results with Theory and Empirical Data

25. We now want to compare this velocity profile with the theoretical Blasius velocity profile for
laminar flow on a flat plate. First, we have to normalize the streamwise Velocity (X) component
with the free stream velocity. Secondly, we have to transform the wall normal coordinate into the
similarity coordinate for comparison with the Blasius profile. The similarity coordinate is
described by

n= y\/% (2.1)

where y (m) is the wall normal coordinate, U (m/s) is the free stream velocity, x (m) is the
distance from the leading edge and v (m?/s) is the kinematic viscosity of the fluid.

26. Place the file “graph 2.25a)” on the desktop. Repeat step 24 to plot Figure 2.25a). Rename the
xy-plot to Comparison with Blasius Profile.
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We see in figure 2.25a) that all profiles at different streamwise positions collapse on the same
Blasius curve when we use the boundary layer similarity coordinate.

1
0.8
e o 2 s x=0.2m
u/U 8/ N T T R N N N B N x=0.4m
0.4 ; 44 T e x=0.6m
/j """"""""""""" x=0.8m
0.2 / —— Theory
/
0 7
0 1 2 4 5 6

Figure 2.25a) Velocity profiles in comparison with the theoretical Blasius profile (full line)

The Reynolds number for the flow on a flat plate is defined as
Re, = — (2.2)

The boundary layer thickness & is defined as the distance from the wall to the location where the
velocity in the boundary layer has reached 99% of the free stream value. The theoretical
expression for the thickness of the laminar boundary layer is given by

4.91x
é = Tres (2.3)
, and the thickness of the turbulent boundary layer
0.16
§= leﬁ (2.4)

From the data of figure 2.24¢) we can see that the thickness of the laminar boundary layer is close
to 3.80 mm at Re,, = 66,877 corresponding to x = 0.2 m. The free stream velocity at x = 0.2 m is
U= 5.069 m/s, see figure 2.22¢) for list of goals in solver window, and 99% of this value is Us =
5.018 m/s. The boundary layer thickness 6§ = 3.83 mm from Flow Simulation was found by
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finding the y position corresponding to the Ug velocity. This value for § at x = 0.2 m and
corresponding values further downstream at different x locations are available in the Plot Data for
Figure 2.25a). The different values of the boundary layer thickness can be compared with values
obtained using equation (2.3). In Table 2.1 are comparisons shown between boundary layer
thickness from Flow Simulation and theory corresponding to the four different Reynolds numbers
shown in figure 2.24c¢). The Reynolds number varies between Re, = 66,877 at x = 0.2 m and

Re, =270,849 at x = 0.8 m.

x (m) | & (mm) & (mm) | Percent (%) Us U m? Re,
Simulation | Theory Difference (m/s) | (m/s) v (T)

0.2 3.83 3.80 0.9 5.019 [ 5.069 | 0.00001516 | 66,877

0.4 5.32 5.36 0.7 5.044 | 5.095 | 0.00001516 | 134,436

0.6 6.45 6.55 1.5 5.064 | 5.115]0.00001516 | 202,458

0.8 7.42 7.55 1.7 5.081 5.133 | 0.00001516 | 270,849

Table 2.1 Comparison between Flow Simulation and theory for laminar boundary layer thickness

27. Place the file “graph 2.25b)” on the desktop. Repeat step 24 to plot Figure 2.25b). Rename the
xy-plot to Boundary Layer Thickness.

0.1
10(L00 100000 100(L000
é/x | o Flow Simulation
——— Theory
0.01
Rex

Figure 2.25b) Comparison between Flow Simulation and theory on boundary layer thickness
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28. We now want to study how the local friction coefficient varies along the plate. It is defined as the
local wall shear stress divided by the dynamic pressure:

Tw
Crn = e (2.12)

The theoretical local friction coefficient for laminar flow is given by

Crx = 0224 Re, < 5-10° (2.13)
and for turbulent flow
Cryx = % 5-10° < Re, < 107 (2.14)

Place the file “graph 2.26” on the desktop. Repeat step 24 but this time choose the sketch x =0 —
0.9 m, uncheck the box for Velocity (X) and check the box for Shear Stress. Use the file “graph
2.26” to create Figure 2.26. Rename the xy-plot to Local Friction Coefficient. Figure 2.26
shows the local friction coefficient versus the Reynolds number compared with theoretical values
for laminar boundary layer flow.

0.1
1(LO 1000 10(|)OO 100000 100(L000
Cf,x 0.01 : Flow Simulation
—— Theory
0.001
Re

X

Figure 2.26 Local friction coefficient as a function of the Reynolds number
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The average friction coefficient over the whole plate Cr is not a function of the surface roughness
for the laminar boundary layer but a function of the Reynolds number based on the length of the
plate Rey; see figure E3 in Exercise 8 at the end of this chapter. This friction coefficient can be
determined in Flow Simulation by using the final value of the global goal, the X-component of
the Shear Force F7, see figure 2.22¢), and dividing it by the dynamic pressure times the area 4 in
the X-Z plane of the computational domain related to the flat plate.

Fp 0.0001475N
pUZA  3:1.204kg/m3-52m?/s?-1m-0.004m

Cf=

=0.00245 (2.15)

UL 5m/s-1m
ReL e —
v 1.516:1075m2/s

=3.3-10° (2.16)

The average friction coefficient from Flow Simulation can be compared with the theoretical value
for laminar boundary layers

Cr = "2 = 0.002312 Re, <5105 2.17)

Rep,

This is a difference of 6 %. For turbulent boundary layers the corresponding expression is

_0.0315
- ReL1/7

Cr 5-105 < Re, < 107 (2.18)

If the boundary layer is laminar on one part of the plate and turbulent on the remaining part the
average friction coefficient is determined by

0.0315 1 s
Cf = Re, 7 Rep (0.0315Re.,7 — 1.328,/Re,,) (2.19)

where Re,, is the critical Reynolds number for laminar to turbulent transition.
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Cloning of the Project

29. In the next step, we will clone the project. Select Tools>>Flow Simulation>>Project>>Clone
Project.... Enter the Project Name “Flat Plate Boundary Layer Study Using Water”. Select
Create New Configuration and exit the Clone Project window. Next, change the fluid to water
in order to get higher Reynolds numbers. Start by selecting Tools>>Flow Simulation>>General
Settings... from the SOLIDWORKS menu. Click on Fluids in the Navigator portion, select Air
and click on the Remove button. Select Water from the Liquids and Add it as the Project Fluid.
Change the Flow type to Laminar and Turbulent; see figure 2.27d). Click on the OK button to

close the General Settings window.

Tools

| BA0-H-E-8-9-|

Window  Help

4

o

Ty
AEC

ﬁ Asset Publisher...

SOLIDWORKS Applications 3

E BE

General Settings...
_:‘,a:;_: Units...

Defeature... @ Computational Domain...
Export To AEC... B Global Mesh...

D'IE Component Control...
Select

Kpress Products » Rapid lInstantzD

Flow Simulation » Project Pl Mew..

SOLIDWOREKS CAM » % Wizard...
Insert *

AMSY5171 3

5 Rebuild
Automatic Rebuild

B Display All Callouts
| Show Basic Mesh

#. Basic Mesh Color

Clone Project...

'El T alrnlatinn Cantral Ointinnc
Figure 2.27a) Cloning the project
Clone Project @
W X
Project Hame L]
Flat Plate Boundary Layer Study Using ' ater
Configuration L
|||='a Create Mew -
[ ] Tools | Window  Help 2 ‘ ﬁ D - E - ﬁ - % -
= Defaull] SOLIDWORKS Applications ’
Xpress Products 3
2 [Default - —— .
Flow Simulation 3 Project
SOLIDWORKS CAM 3
Options ~ Insert
ANSYS17.1 »
D Copy results e~ oo General Settings...

Figure 2.27b) Creating a new project Figure 2.27¢)
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Figure 2.27d) Selection of fluid and flow type

Select Tools>>Flow Simulation>>Computational Domain... Set the size of the computational
domain to the values shown in figure 2.28a). Click on the OK button to exit. Select Tools>>Flow
Simulation>>Global Mesh... from the SOLIDWORKS menu, select Manual Type and change
the Number of cells per X: to 400 and the Number of Cells per Y: to 200. Also, click on
Control Planes. Change the Ratio for X to -5 and the Ratio for Y to -100. Click on the green
check mark above Ratio, see Figure 2.28b). This will increase the number of cells close to the
wall where the velocity gradient is high. Select Tools>>Flow Simulation>>Calculation Control
Options... from the SOLIDWORKS menu. Change the Maximum travels value to 5 by first
changing to Manual from the drop down menu. Travel is a unit characterizing the duration of the
calculation. Click on the OK button to exit.

Size and Conditions ~
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&, 01zm

010007 m
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BT G G [ (]
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Figure 2.28a) Setting the size of the computational domain
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Figure 2.28b) Increasing the number of cells and changing the distribution of cells
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Figure 2.28c) Calculation control options
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Figure 2.28d) Setting maximum travels

Select Tools>>Flow Simulation>>Project>>Show Basic Mesh from the SOLIDWORKS menu.
We can see in figure 2.28f) that the density of the mesh is much higher close to the flat plate at
the bottom wall as compared to the region further away from the wall.

Tools | Window  Help »* | ﬁ- D - B? - ﬁ - @ - - [} e {ﬁ} - Fla... ® Search S

4

SOUDWORKS Applications r E @
Xpress Products » Rapid |Instant2n
Flow Simulation » Project bl [8 New.
b - Wizard...
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Insert [
AMSYS17.1 3
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General Settings...
ﬁ Asset Publisher...

_:ﬂ__: Units...
Display All Callouts
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B Fvnnrt Th AFC i Glnhal Mech Show Basic Mesh

Figure 2.28¢) Showing the basic mesh

Figure 2.28f) Mesh distribution in the X-Y plane

Chapter 2 - 28 -



Flat Plate Boundary Layer

31. Right click the Inlet Velocity Boundary Condition in the Flow Simulation analysis tree and
select Edit Definition.... Open the Boundary Layer section and select Laminar Boundary
Layer. Click OK to exit the Boundary Condition window. Right click the Reynolds number at
x = 0.2 m goal and select Edit Definition.... Change the viscosity value in the Expression to
1.004E-6. Click on the OK button to exit. Change the other three equation goals in the same way.
Select Tools>>Flow Simulation>>Solve>>Run to start calculations. Click on the Run button in
the Run window.

Boundary Layer
(™) Turbulent

i@ Laminar

Figure 2.29a) Selecting a laminar boundary layer

Pt ills) | |Heynu:-|u:|s nurber at © = 0.2 m Dimengionless L, ~

Expression
{PG Velocity (X) at x = 0.2 m}*0.2,/1.004E-6

Figure 2.29b) Modifying the equation goals

] 1
Run F . ...
Bun

[V] Mesh [ Take previous results

Fsohe

@ Mew calculation

Continue calculation

Figure 2.29¢) Creation of mesh and starting a new calculation
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. -
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Figure 2.29d) Solver window and goals table for calculations of turbulent boundary layer

32. Place the file “graph 2.30a)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Velocity
Boundary Layer. An Excel file will open with a graph of the streamwise velocity component
versus the wall normal coordinate; see figure 2.30a). We see that the boundary layer thickness is
much higher than the corresponding laminar flow case. This is related to higher Reynolds number
at the same streamwise positions as in the laminar case. The higher Reynolds numbers are due to
the selection of water as the fluid instead of air that has a much higher value of kinematic
viscosity than water.
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Figure 2.30a) Flow Simulation comparison between turbulent boundary layers at Re,, = 10® —
4.04-10°

As an example, the turbulent boundary layer thickness from figure 2.30a) is 3.55 mm at x = 0.2 m
which can be compared with a value of 4.45 mm from equation (2.4), see table 2.2.

o (mm) J (mm) %

x (m) | Simulation | Empirical | Difference | Us(m/s) | U (mm/s) v (m?%/s) Rex
0.2 3.37 4.45 24 4.976 5.026 | 1.004E-06 | 1,001,237
0.4 6.41 8.05 20 4.996 5.047 | 1.004E-06 | 2,010,673
0.6 9.26 11.39 19 5.015 5.065 | 1.004E-06 | 3,027,129
0.8 12.02 14.56 17 5.032 5.083 | 1.004E-06 | 4,050,108

Table 2.2 Comparison between Flow Simulation and empirical results for turbulent boundary
layer thickness

Place the file “graph 2.30b)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Boundary
Layer Thickness. An Excel file will open with a graph of the boundary layer thickness versus the
Reynolds number; see figure 2.30b).

0.1
1000000

10000000
7777777777 Flow Simulation

o/x

——— Empirical Data

0.01

Figure 2.30b) Boundary layer thickness for turbulent boundary layers at Re,, = 10° — 4.04 - 10°
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Place the file “graph 2.31” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Comparison with One-
Sixth Power Law. An Excel file will open with Figure 2.31. In figure 2.31 we compare the
results from Flow Simulation with the turbulent profile for » = 6. The power law turbulent
profiles suggested by Prandtl are given by

Y 2yi/n
;= @) (2.20)
1 —/_’/_’4
—
0.8
R 7 s x=0.2m
u/U fffffff x=0.4m
o )7 R A S S Y A S S S N Y ey x=0.6m
""""""""""""" x=0.8m
n=6
0.2
0
0 0.2 0.4 0.6 0.8 1

y/8

Figure 2.31 Velocity profiles compared with 1/6 power law for turbulent profile

Place the file “graph 2.32” on the desktop. Repeat step 24 and choose the sketch x =0 — 0.9 m,
uncheck the box for Velocity (X) and check the box for Shear Stress. Rename the xy-plot to
Local Friction Coefficient for Laminar and Turbulent Boundary Layer. An Excel file will
open with figure 2.32. Figure 2.32 is showing the Flow Simulation is able to capture the local
friction coefficient in the laminar region in the Reynolds number range 10,000 — 150,000. At Re
= 200,000 there is an abrupt increase in the friction coefficient caused by laminar to turbulent
transition. In the turbulent region the friction coefficient is decreasing again but the local friction
coefficient from Flow Simulation is significantly lower than empirical data.
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Figure 2.32 Comparison between Flow Simulation (dashed line) and theoretical laminar and
empirical turbulent friction coefficients

The average friction coefficient over the whole plate Cr is a function of the surface roughness for
the turbulent boundary layer and also a function of the Reynolds number based on the length of
the plate Re;; see figure E3 in Exercise 8. This friction coefficient can be determined in Flow
Simulation by using the final value of the global goal, the X-component of the Shear Force Frand
dividing it by the dynamic pressure times the area 4 in the X-Z plane of the computational
domain related to the flat plate; see figure 2.28a) for the size of the computational domain.

= L= 01309N =0.00262 2.21)
SPUZA E-998kg/m3-52m2/52-1m-0.004m
Re, =YL =_SM/sim__ _ 49g8.106 (2.22)

v 1.004-10~6m2/s

The variation and final values of the goal can be found in the solver window during or after
calculation by clicking on the associated flag; see figures 2.33 and 2.29d).

Chapter 2 - 33 -



Flat Plate Boundary Layer

f_i Solver: Flat Plate Boundary Layer Study Using Water [Default(1})] (Flat Plate Boundary Layer Study EDIQ.SLDPRH:

File Calculation View Inset Window Help

BN > 4|9 |[E0F]H e | 0
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Figure 2.33 Current value of the global goal
For comparison with Flow Simulation results we use equation (19) with Re_,. = 150,000

00315 1
f - R€L1/7 ReL

6
(0.0315Re,,7 — 1.328,/Re,, ) = 0.00341 (2.23)

This is a difference of 23%.

References

[1] Cengel, Y. A., and Cimbala J.M., Fluid Mechanics Fundamentals and Applications, 1
Edition, McGraw-Hill, 2006.

[2] Fransson, J. H. M., Leading Edge Design Process Using a Commercial Flow Solver,
Experiments in Fluids 37, 929 — 932, 2004.

[3] Schlichting, H., and Gersten, K., Boundary Layer Theory, 8" Revised and Enlarged Edition,
Springer, 2001.

[4] SOLIDWORKS Flow Simulation 2018 Technical Reference

[5] White, F. M., Fluid Mechanics, 4" Edition, McGraw-Hill, 1999.

Exercises

2.1 Change the number of cells per X and Y—see figure 2.16b)—for the laminar boundary layer
and plot graphs of the boundary layer thickness, displacement thickness, momentum
thickness and local friction coefficient versus Reynolds number for different combinations of
cells per X and Y. Compare with theoretical results.

2.2 Choose one Reynolds number and one value of number of cells per X for the laminar

boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per Y. Compare with theoretical results.
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2.3 Choose one Reynolds number and one value of number of cells per Y for the laminar
boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per X. Compare with theoretical results.

2.4 Import the file “Leading Edge of Flat Plate”. Study the air flow around the leading edge at 5
m/s free stream velocity and determine the laminar velocity boundary layer at different
locations on the upper side of the leading edge and compare with the Blasius solution. Also,
compare the local friction coefficient with figure 2.26. Use different values of the initial mesh
to see how it affects the results.

Figure E1. Leading edge of asymmetric flat plate; see Fransson (2004)

2.5 Modify the geometry of the flow region used in this chapter by changing the slope of the
upper ideal wall so that it is not parallel with the lower flat plate. By doing this you get a
streamwise pressure gradient in the flow. Use air at 5 m/s and compare your laminar
boundary layer velocity profiles for both accelerating and decelerating free stream flow with
profiles without a streamwise pressure gradient.

Figure E2. Example of geometry for a decelerating outer free stream flow.
2.6 Determine the displacement thickness, momentum thickness and shape factor for the
turbulent boundary layers in figure 2.30a) and determine the percent differences as compared

with empirical data.

2.7 Change the distribution of cells using different values of the ratios in the X and Y directions,
see figure 2.28b), for the turbulent boundary layer and plot graphs of the boundary layer
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thickness, displacement thickness, momentum thickness and local friction coefficient versus
Reynolds number for different combinations of ratios. Compare with theoretical results.

2.8 Use different fluids, surface roughness, free stream velocities and length of the computational
domain to compare the average friction coefficient over the entire flat plate with figure E3.
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Figure E3. Average friction coefficient for flow over smooth and rough flat plates, White (1999)
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